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● Safety precautions 
 Before you use the printer, carefully read the User’s manual to ensure that you use the printer 

correctly.  Be aware that the content complies with the standards at the time the User’s manual 
section related to safety, including usage and safety precautions, was created. 

 
● Modifications 
 For product safety, it is prohibited to modify the CX-02/CX-02 (S) printer, CX-02/CX-02 (S) printer 

driver, and CD contents. 
 

● Copyright 
 The copyrights, trademark rights, and other intellectual property rights related to documents and 

programs included with this product are the property of CITIZEN SYSTEMS JAPAN CO., LTD. and 
other rights holders.  

 You cannot copy and use these items without the permission of CITIZEN SYSTEMS JAPAN CO., LTD. 
except where permitted by applicable laws. 

 
 Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United 

States and in other countries. 
 LEADTOOLS Copyright (C) 2008 LEAD Technologies, Inc. 
 

●About the country of delivery 
 Not for resale/use in the U.S. 
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Chapter 1 Installation 
Installation procedure 

The installation procedure is made up of three steps. 
The details of each step are explained below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Prepare the printer and computer → “1.1 Prepare the printer and computer” 

Install the driver package → “1.2 Install the driver package” 

On 

USB cable 

Insert the included CD into the disk drive, and then 
install the driver package. 
 

Install the printer driver → “1.3 Install the printer driver” 

Connect the USB cable, switch on the printer, and then 
install the printer driver. 
After installation is complete, restart the computer. 

At this point, the USB cable is not yet 
connected. 
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1.1 Prepare the printer and computer         
Make sure that the printer power is off. 
Prepare a USB cable.  However, do not use the USB cable to connect the printer and computer at this time. 
 
Log in to Windows as an administrator.  The following explanation presumes that the operations are carried 
out with administrator privileges. 
 
 
 
 
 
 
 
 
 
 
 

1.2 Install the driver package                  
Insert the included CD into the disc drive. 
Open Windows Explorer, and then click the corresponding drive. 
If AutoPlay is enabled, a message appears stating “Tap to choose what happens with this disk”.  Click the 
message and select “Open folder to view files Windows Explorer”. 
If AutoPlay is enabled in Windows 7, select “Open folder to view files using Windows Explorer”. 
If AutoPlay is enabled in Windows 8, a message appears stating “Tap to choose what happens with this disk”. 
Click the message and select “Open folder to view files Windows Explorer” 
Select one of the following folders on the included CD. 
 

  CD drive:¥CX-02_Driver 
 

 
Figure 1.2.1 Driver Package folder 

 

  

CAUTION: 
The display settings of the computer must be set as follows.  If the settings differ from the following, 
the printing preferences screen and other items may not fit in the display area. 
 
· Resolution: At least 1280x800 
· Size of text and other items (DPI): 100% 
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In the selected folder, double click the following file: DriverInstall.CMD.  (Depending on your usage 
environment, the .CMD extension may not be displayed.) 
The driver package installer appropriate for your operating system (32-bit or 64-bit) is selected automatically. 
 

 
Figure 1.2.2 Installation file 

 
 

When you start the installer, a window appears for selecting the language that will be used during the 
installation.  After you select the language to use, click “OK”. 
 

 
Figure 1.2.3 Language selection screen 

 
 

Click “Next >” when the Installation Wizard screen appears. 
 

 
Figure 1.2.4 Installation Wizard start screen 
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Click “Install” when the installation is ready. 
 

 
Figure 1.2.5 Installation start confirmation screen 

 
 

When the installation starts, a screen appears that shows the installation status. 
 

 
Figure 1.2.6 Installation status screen 
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When a User Account Control dialog box appears, click “Yes”. 
 

 
Figure 1.2.7 User Account Control 

 
 
Click “Install” when the Windows Security confirmation display appears. 
 

 
Figure 1.2.8 Windows Security confirmation 

 
 
Installation of the driver package starts.  Wait until installation finishes. 
Click “Finish” when the Installation Wizard completion screen appears. 
 

 
Figure 1.2.9 Finish of Installation Wizard 
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1.3 Install the printer driver  
 
Use the USB cable to connect the printer and computer, and then switch on the power of the printer. 
After the printer is recognized, installation of the driver starts. 
*For the connection, see the User’s manual of the printer. 
 
In Windows 7, if driver installation starts, the following message appears in the taskbar: “Installing device 
driver software”. 
In Windows 8 and 10, this message does not appear.  Proceed to page 8. 

 
Figure 1.3.1 Driver installation message 

 
 
If you click on this message, the Driver Software Installation screen appears and displays the installation 
status of the driver.  If “Close” is clicked, this screen closes. 
 

 
Figure 1.3.2 Installing the driver software 

 
 
*About the “Skip obtaining driver software from Windows Update” option 
If your operating system is configured to obtain driver software from Windows Update, it may take time for 
installation to complete because the process searches for drivers from Windows Update first.  You can 
reduce the time until the completion of installation by choosing to skip obtaining driver software from Windows 
Update.  (Depending on your operating system, it may take some time until installation is complete.) 
From the Driver Software Installation dialog box, click "Skip obtaining driver software from Windows Update". 
 

 
Figure 1.3.3 Option to skip obtaining driver software from Windows Update 
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A confirmation dialog box appears.  Click “Yes”. 
 

 
Figure 1.3.4 Confirmation to skip getting driver software from Windows Update 

 
 
Soon after installation starts, a message appears in the taskbar stating “Your device is ready to use”, and then 
printer driver installation finishes. 

 
Figure 1.3.5 Installation complete message 

 
 
If you click on the message, the Driver Software Installation dialog appears, and the “Your device is ready to 
use” message appears.  Click “Close”. 
(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar 
message is not displayed.) 
 

 
Figure 1.3.6 Completion of driver software installation 
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Click “Start”, and then click “Windows System” -> “Control Panel” to open the Control Panel. 
In Windows 7, click “Start”, and then click “Control Panel” to open the Control Panel. 
In Windows 8, right click the “Start” screen.  In the bottom right area, select “All Apps”, and then select 
“Control Panel”.  In Control Panel, click “View devices and printers”. 
 

 
Figure 1.3.7 Control Panel 

 
 
In Devices and Printers, make sure that “CITIZEN CX-02” is present. 
Note: In Windows 8 and 10, when the printer is offline (the printer is not on and connected), “CITIZEN CX-02” 
      icon is not displayed. 
This completes installation of the CITIZEN CX-02 printer driver. 
 

 
Figure 1.3.8 Devices and Printers screen 

 
After the installation of the printer driver is complete, always restart the computer.  
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In Windows 7, when it was not possible to install the printer driver correctly, the following message appears in 
the taskbar: “Device driver software was not successfully installed”. 

 
Figure 1.3.9 Message indicating that the driver was not installed 

 
 
If you click on this message, the Install driver software screen appears and displays the message “Device 
driver software was not successfully installed”.  Click “Close”. 
(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar 
message is not displayed.) 
 
When the driver could not be installed correctly, see the next section, “1.4 Install drivers for unspecified 
devices”, and then install the printer driver. 
 

  
Figure 1.3.10 When the driver was not installed correctly 
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1.4 Install drivers for unspecified devices  
 
If you connect a printer that is on to the computer before installing the driver package, a device is created 
under “Unspecified” in Devices and Printers. 
 

 
Figure 1.4.1 Photo Printer under Unspecified 

 
In such a case, use the following method to install the printer driver. 
Furthermore, use the following method to install the printer driver if you use the standard installation 
procedure (install the driver package, connect the printer, and then install the printer driver), but the driver is 
not installed correctly, and a device is created under “Unspecified”. 
 
 
1. Install the driver package 

When the driver package has not yet been installed, install it by following the procedure in “1.2 Install the 
driver package”. 
If you install the driver package, installation of the printer driver for the unspecified device completes it 
automatically. 

 
 
2. Installing a driver for an unspecified device 

After installing the driver package, the driver installation procedure for an “Unspecified” device is different 
for Windows 7 and Windows 8,10. 
For Windows 8,10, refer to page 11. 
For Windows 7, refer to page 12. 
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In Windows 8,10: 

1. Right-click “Photo Printer” of the “Unspecified” device in “Devices and Printers”, and click “Remove 
device” from the pull-down menu. 
 

 
Figure 1.4.2 Delete “Photo Printer” 

 
2. Disconnect the USB cable connected to the printer. 
3. Restart your computer. 
4. After starting up the computer, connect the USB cable again and turn on the printer. 

 
In Devices and Printers, make sure that “CITIZEN CX-02” is present. 
Note: When the printer is offline (the printer is not on and connected), the “CITIZEN CX-02” icon is not 

displayed. 
This completes installation of the printer driver. 
 

 
Figure 1.4.3 Devices and Printers screen 

 
After the installation of the printer driver is complete, always restart the computer. 
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In Windows 7: 

In “Devices and Printers”, under “Unspecified”, right click on “Photo Printer”.  From the menu, click 
"Troubleshoot". 

 

 
Figure 1.4.4 Photo Printer under Unspecified 

 
The Install a driver for this device screen appears.  Click “Apply this fix”. 
The computer searches for a driver automatically, and then installs it. 
 

 
Figure 1.4.5 Applying a fix 
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If the driver is installed, the message “Troubleshooting has completed” appears.  Click “Close the 
troubleshooter” to close the troubleshooting window. 
 

 
Figure 1.4.6 Completing troubleshooting 

 
In Devices and Printers, make sure that “CITIZEN CX-02” is present. 
This completes installation of the printer driver. 
 

 
Figure 1.4.7 Devices and Printers screen 

 
After the installation of the printer driver is complete, always restart the computer. 
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Chapter 2 Properties 
 
You can configure various printer settings from the Properties of the driver.  Make sure you understand the 
contents well before changing settings.  To use the properties, log in as an administrator.  Depending on the 
application you are using, you must perform this operation from the print settings of the application. 
 

2.1 Open the printer properties  
  
 
 
 
 
 
 

   
 
 
 
 
 

   
 
  

2. From the Control Panel, click “View devices and printers” to open the Devices and Printers screen. 

1. Click the “Start”, click “Windows System”,and then click “Control Panel” to open the Control Panel. 
In Windows 7, Click “Start”, and then click “Control Panel” to open the Control Panel. 
In Windows 8, right click the “Start” screen, click “All Apps”, and then click “Control Panel” to open 
the “Control Panel”. 
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4. “CITIZEN CX-02” Properties screen appears. 

3. Right click “CITIZEN CX-02” icon. From the menu, click “Printer Properties”to open the Properties 
dialog box. 
Note: In Windows 8 and 10, when the printer is offline (the printer is not on and connected), “CITIZEN 

CX-02” icon is not displayed. 
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2.2 Print settings functions  
If you select the basic settings from the Properties screen, you can change various print settings. 
 
2.2.1 Layout 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Orientation 

Set the print orientation to “Portrait” or “Landscape”. 
For details, refer to “2.6 Orientation”. 

 
Page Order 

In the application, specify the order when multiple copies of an image are printed. 
 
  Example) Print order 
 
 
 
 
 
 
 
 
 
 
Page Format 

  Pages per Sheet 
    Set printing of the specified division size.  In most situations, set “1”. 
 
    Example) Division size 
 
 
 

  

Figure 2.2.1 Layout tab 

Front to Back 

Back to Front  

No.1 No.2 No.3 

1 division 

 

4 divisions 9 division 
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2.2.2 Advanced options 

If you select “Advanced...” on the Layout tab, you can configure various advanced options. 
 
 
. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Paper/Output 

  Paper Size 
Specify the paper size.  Match the paper size with the size of the media set in the printer. 
You can enable multiple layout settings by setting the paper size.  See later sections for details. 
 

  Copy Count 
  You can specify the number of copies to be published for images. 
 
 
 
  

Figure 2.2.2.2 Advanced options tab Figure 2.2.2.1 Advanced settings 
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Graphic 

  Print Quality 
  Specify the resolution. 

Print quality Function 

High-speed Print using high speed mode 

High-quality Print using high quality mode 
 
  ICM Method 

ICM Method Function 

ICM Disabled Synchronized with “Color Adjustment Disabled” in the 2.2.4 Option. 

ICM Handled by Host System Synchronized with “Color Adjustment ICM” in the 2.2.4 Option. 

Manage colors using the driver. 

ICM Handled by Printer When this item has been selected, operation is the same as “ICM 

Handled by Host System”. 

 
  ICM Intent 
   Set the rendering method when using ICM.  For the ICC profile, always set to “Pictures”. 
    Do not use other settings. 
 
 
Document Options 

  Advanced Printing Features 
Always set “Enabled”.  Do not use other settings. 

 
  Pages per Sheet Layout 

Set the layout direction of an image when the Pages per Sheet setting is set for multiple divisions. 
 
 
Printer Features 

  Border 
Synchronized with Border in the Option. 

 

  Overcoat Finish 

Set the overcoat finish method for the surface of printed items from the following four types. 

Overcoat Finish Function 

Glossy Create an item with a glossy finish. 

Matte Create an item with a matte finish. 

Luster Create printouts with rough surface and semi-gloss finish that has 

less glare.  

Fine Matte Create printouts with fine grain and strong matte finish. (*1) 

*1: Supported by version 01.01 and later. 
 

  *CX-02 (S) can only print with a glossy finish.  Even if settings are set to an overcoat finish other than 

glossy, these settings will not be applied. 
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  Print Re-try 

Specify whether to print data in the printer buffer after a printer error has been cleared. 

Print Re-try Function 

Disable Clear the print data in the printer buffer when a printer error occurs. 

You must send the cleared print data again after the error is cleared. 

When you use an application with an error recovery function, select this option. 

Enable Save print data in the printer buffer when an error occurs. 

The printing process is restarted from the saved data after the error is cleared. 

Note that if the power is switched off, the data is not saved. 

 

Depending on the content of the printer error, it may be necessary to restart the printer to clear the error.  In such 

cases, the print data in the printer buffer is cleared regardless of the Print Re-try setting. 

 

The following section shows the operation for each Print Re-try setting by error. 

Error content When Print Re-try is disabled When Print Re-try is enabled 

Paper end You must send the unprinted image 

data again after the error is cleared. 

The printing process is restarted from 

the data saved in the printer buffer after 

the error is cleared. 

When the paper initialization operation 

is to be carried out, printing occurs 

afterwards. 

Ribbon end 

Cover open 

Paper jam (*1) 

Ribbon error (*1) 

Paper setting error 

Data error Because the printer must be switched 

on and off to clear the error, the print 

data in the printer buffer is cleared 

regardless of the Print Re-try setting. 

 

After the printer has restarted, you must 

send the unprinted image data again. 

 

Because the printer must be switched 

on and off to clear the error, the print 

data in the printer buffer is cleared by 

switching the printer off, even when the 

Print Re-try setting is Enabled. 

 

After the printer has restarted, you must 

send the unprinted image data again. 

Head voltage error 

Head position error 

Power supply fan stopped 

Cutter error 

Head temperature error 

Media temperature error 

RFID module error 

System error 
 

*1: After the printer stops due to an error, follow the user’s manual of the printer to eliminate the cause of the paper or 

ribbon error. 

 

 

2inch cut 

Specify whether to cut paper into multiple sheets with a 2-inch length when you use a specified paper 

size. 

2inch cut Function 

Disable Cut at the normal size. 

Enable Cut at 2-inch lengths so that the 6 x 4 size becomes two sheets and the 

6 x 8 size becomes four sheets. 
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＜Multiple layout＞ 

When 5 x 7, 6 x 8 or 6 x 9 media is used, you can use a two-picture layout.  You can enable multiple layout 

settings by setting the paper size of the printer driver.  If it sends multiple images from the application, the 

printer driver allocate them automatically as the multiple layout. 

The following section shows the image sizes. 
 
 Layout settings 

Driver paper size setting Paper direction 
Paper size 

length x height (mm) 
Media used 

(5x3.5) Portrait 131.1x 92.1 5x7, 6x8, 6x9 

Landscape  92.1x131.1 

PR (3.5x5) Portrait  92.1x131.1 

Landscape 131.1x 92.1 

(6x4) Portrait 156.1x105.0 6x8, 6x9 

Landscape 105.0x156.1 

PR (4x6) Portrait 105.0x156.1 

Landscape 156.1x105.0 

(6x4.5) Portrait 156.1x117.3 6x9 

Landscape 117.3x156.1 

PR (4.5x6) Portrait 117.3x156.1 

Landscape 156.1x117.3 

 

   Note)  Depending used conditions, the rewinding print might be carried out instead of the multiple 

  layout. 

Because they are carried out by the print job, multiple layout are carried out when there are 

multiple images in a single job. 

If you want to layout the same image, send the same number of images as the umber-of-sheets

 setting. 

The printer handles two pictures at one time and cuts the paper after it is ejected. 

 

 

 

 

 

 

 

 

 

 

 

 
  

Same-size images on one sheet 

Layout of 2 pictures: set x 2 
Cut when paper is ejected 



 

21 
CITIZEN SYSTEMS JAPAN CO., LTD. 

 

[CX-02/CX-02 (S) Printer Driver] User’s Manual (For Windows 7, 8, 10) 

 

 

＜Rewind Print function＞ 

If you set the paper size setting to (6 x 4) when printing 6 x 4 size to 6 x 8 size media, printing is optimized to 

reduce consumption of the ribbon. 

 
Furthermore, if you set the paper size setting to (5x3.5) or (6x4.5) when printing 5 x 3.5 size to 5 x 7 size 

media or when printing 6 x 4.5 size to 6 x 9 size media, printing is similarly optimized to reduce consumption 

of the ribbon. 
 

The following shows the difference in ribbon consumption when the paper size is set to (6x4) for 6x8-sized 

media. 

 CX-02/CX-02 (S) 

When printing one sheet at 

6 x 4 size once 

 

 

 

 

 

 

*After printing, the ribbon is rewound and adjusted to the next print position. 

When printing one sheet at 

6 x 4 size twice 

 

 

 

 

 

 

 

 

*After the first sheet is printed, the ribbon is rewound, and the second sheet is printed. 

 

When printing two sheets 

at 6 x 4 size once 

 
 
 
  
 
 
 
*Two sheets are printed at the same time in a multiple layout. 

 

When printing one 6 x 4 

size sheet once, and then 

printing two 6 x 4 size 

sheets once 

 

 

 

 

 

 

 

 

 

 

 

*After the first sheet is printed, the ribbon is rewound, and the second and following sheets are 

printed.  Furthermore, after the third sheet is printed, the ribbon is rewound and adjusted to the next 

print position. 

 

 

 

  

Used for the 
next printing 

Used for the 
next printing 
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< Application usage example > 

 This usage example uses Windows Explorer. 

  

Step 1. In Windows Explorer, select two or more pictures. 

Next, click “Print”. 

 

Select 2 or more images 

Step 3. Click “Printer Properties...”. 

Step 4. Set the Orientation to “Portrait”, 

       and click “Advanced...”. 

 

Step 2. Select “Fit picture to frame” check box, and 

then click “Options...”. 

 

Step 5. Set the paper size to the setting of the 

multiple layout. 

Click “OK” twice to close the dialog boxes in 

Step 5 and 4. 

Step 6. Click the “Print” button. 
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2.2.3 Paper/Quality 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Color   

Set Color.  Do not use black and white. 
 
 
2.2.4 Option 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Border 

Specify a border for printing.  (Select the check box for a border.) Synchronized with Border Enable / 

Disable in the Advanced settings.  

Figure 2.2.3 Paper/Quality tab 

Fig 2.2.4.1 Option tab Fig 2.2.4.2 Sharpness setting 
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Sharpness 

Process sharpness using one of the 11 stages (Figure 2.2.4.2).  If the setting is “0 (Default)”, sharpness 
is not processed. 
Moving to the minus (-) side blurs the image and moving to the plus (+) side sharpens the image. 

 
Color Adjustment 

None 
Synchronized with the ICM Method in the Advanced settings. If this check box is selected, ICM is 
disabled, the Color adjustment tab is also disabled, and the printer driver does not carry out color 
adjustment. 

Handled by Driver 
If this check box is selected, ICM is disabled, and the 2.2.5 Color Adjustment is enabled.  
The result is applied to the adjustment values of the following items: Gamma, Brightness, Contrast, 
and Chroma. 

ICM 
Synchronized with the ICM Method of the Advanced settings (ICM Handled by Host System).  
If this check box is selected, the driver manages colors. 

ICM & Driver 
If this check box is selected, ICM (color management) and the 2.2.5 Color Adjustment are enabled. 

 
Language 

Change the display language for the following items: “Option”, “Color Adjustment”, and “Printer Info”. 
The selected language is enabled the next time the print settings are displayed. 

 
    [Available languages] 

・Japanese 

・English (US) 

・French (France) 

・German (Germany) 

・Russian (Russia) 

・Spanish (Spain) 

・Italian (Italy) 

・Korean 

・Chinese (People's Republic of China) 

・Chinese (Taiwan) 

 

・When your operating system environment corresponds with one of the above settings, the default 

display language is the language of the corresponding country. 
Furthermore, when your operating system environment does not correspond with one of the above 
settings, the default display language is English. 

 

・To use a language different from that of your operating system, you must install the following font for the 

corresponding language. 
 

Language Font 

Japanese Meiryo / Yu Gothic UI <Windows 10> 

English (US) Segoe UI 

French (France) Segoe UI 

German (Germany) Segoe UI 

Russian (Russia) Segoe UI 

Spanish (Spain) Segoe UI 

Italian (Italy) Segoe UI 

Korean Malgun Gothic 

Chinese (People's Republic of China) Microsoft YaHei 

Chinese (Taiwan) Microsoft JhengHei 

 

About 

 Show the driver version. 
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2.2.5 Color Adjustment 

 If the Handled by Driver check box is selected in the 2.2.4 Option, the adjustment values of the Color 
Adjustment tab are applied to the image.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 The following section shows the setting ranges on the Color Adjustment tab. 
 

Adjustment item Adjustment value 
Gamma -100 (dark) to 100 (bright) (“0” results in no adjustment, γ2.0 to 0.5) 

Adjust the density of the half-tone section of the image.  Increasing the gamma value 
brightens the half-tone section. 
Sync check box 
 ON: Set RGB to same value. 
 OFF: Set RGB to different value. 
 

Brightness -100 (dark) to 100 (bright) (“0” results in no adjustment) 
Adjust the brightness of the image.  Increasing the brightness value brightens the 
entire image. 
Sync check box 
 ON: Set RGB to same value. 
 OFF: Set RGB to different value. 
 

Contrast -100 (weak) to 100 (strong) (“0” results in no adjustment) 
Adjust the contrast of the image.  Increasing the contrast value increases the 
difference of brightness and darkness. 
Sync check box 
 ON: Set RGB to same value. 
 OFF: Set RGB to different value. 
 

Chroma -100 (weak) to 100 (strong) (“0” results in no adjustment) 
Adjust the chroma of the image. 
 

  
  

Fig 2.2.5 Color Adjustment tab 
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2.2.6 Printer information 

View the printer information. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The following section shows the information displayed in the Printer Info tab. 
Display item Display details 

Media Info This area shows, for example, the size and remaining number of printable sheets for the 
ribbon media in the printer. 
* Media information is not displayed when a media type not supported by the printer has been 
loaded. (Figure 2.2.6.2) 

Printer Status Displays the status of the printer using icons and characters. 

 
Display icon 

(Color) 
Display characters Status/Response 

 
(Green) 

Waiting Printing is possible. 

 
(Blue) 

Printing The printer is printing. 

 
(Yellow) 

Door open Front door is open. 
Close the front door. 

 
(Yellow) 

Ribbon end No ribbon remains. 
Load new media. 
(Replace the paper and ribbon as a set.) 

 
(Yellow) 

Paper end No paper remains. 
Load new media. 
(Replace the paper and ribbon as a set.) 

 

 

Fig 2.2.6.1 Printer Information tab Figure 2.2.6.2 Display when incorrect media is loaded 
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Display item Display details 

  

 
* A warning message is displayed when a media type not supported by the printer has been 
loaded.(Figure 2.2.6.2) 

 

Display icon 
(Color) 

Display characters Status/Response 

 
(Gray) 

Offline The printer cannot be recognized. 
Connect the printer and computer, and then turn on 
the power. 

 
(Purple) 

Cooling head The head is being cooled. 
Please wait a while.  
Printing will resume automatically. 

 
(Orange) 

Ribbon error The ribbon is not set correctly. 
Reload the ribbon properly. 

 
(Orange) 

Paper size 
setting error 

The printer settings and size of the installed ribbon 
do not match. 
Check the paper size setting and ribbon size. 

 
(Orange) 

Paper jam A paper jam was detected. 
Remove the paper and reload it properly. 

 
(Red) 

System error System error. 
Restart the printer and computer. If the printer does 
not recover after the restart, contact the service 
center. 

Total Count Total count of printed sheets (printing other than 6x4.5, 6x4 or 5x3.5 size will count as two 
sheets). 

Firmware Version Version of the control program of the printer.  xx.xx indicates the version. 

・CX-02 xx.xx 

Serial No. Serial number of the printer. 

Color Control Data Printer color control data. 

 
 

  



 

28 
CITIZEN SYSTEMS JAPAN CO., LTD. 

 

[CX-02/CX-02 (S) Printer Driver] User’s Manual (For Windows 7, 8, 10) 

 

 

2.3 Default values for settings  
 
 The following section shows the default values of the settings (at installation).  If the settings have been 
 changed, and the printer driver no longer operates normally, return to the default values shown below. 
 
 Note) Depending on the service pack of your operating system or your usage environment, the default 
      values at installation may differ from those in the chart below. 
 

Chart 2.3 Default print settings 

Tab Setting Value 

Layout 

Orientation Portrait 

Page Order Front to Back 

Pages Per Sheet 1 

Paper/Quality Color Color 

Option 

Border Disable 

Sharpness 0 (Default) 

Color Adjustment ICM 

Language setting English 

Color 
Adjustment 

Gamma 0 

Brightness 0 

Contrast 0 

Chroma 0 

Advanced 
settings 
(In the Layout tab, 
click "Advanced...") 

Paper/Output 
Paper Size (6x4) 

Copy Count 1 Copy 

Graphic 

Print Quality High-speed 

Image Color Management 
ICM Method 

ICM Handled by Host 
System 

ICM Intent Pictures 

Document 
options 

Advanced Printing Features Enabled 

Pages per Sheet Layout Right then Down 

Printer function 

Border Disable 

Overcoat Finish Glossy 

Print Re-try Enable 

2inch cut Disable 

 

 

 
  



 

29 
CITIZEN SYSTEMS JAPAN CO., LTD. 

 

[CX-02/CX-02 (S) Printer Driver] User’s Manual (For Windows 7, 8, 10) 

 

 

2.4 Color management  
Use Color management to specify the color profile.  The installer associates “CX2_0101.icc” by default. 
 
 
Step 1. From the Printer Properties, select the Color Management tab, and then click “Color Management...”. 
 

 
Fig 2.4.1 Color Management 

 
 
Step 2. From Device, select “CITIZEN CX-02”. 
 

 
Fig 2.4.2 Color Management Window 

 
 

 
  

The installer associated this file 
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2.5 Print Area  
 
The following section shows the image sizes and numbers of dots generated by the paper size setting of the 
driver. 
 

Paper size Orientation 

Image size 
(width x height) 

Number of image dots 
(width x height) 

(inch) (mm) 
High-speed 

(300x300 dpi) 
High-quality 

(600x600 dpi)*1 

(5x3.5) 
Portrait 5” x 3.5” 131.1 x 92.1 1548 x 1088 3096 x 2176 

Landscape 3.5” x 5”  92.1 x 131.1 1088 x 1548 2176 x 3096 

(5x5) 
Portrait 5” x 5” 131,1 x 130,4 1548 x 1540 3096 x 3080 

Landscape 5” x 5” 130,4 x 131,1 1540 x 1548 3080 x 3096 

(5x7) 
Portrait 5” x 7” 131.1 x 181.0 1548 x 2138 3096 x 4276 

Landscape 7” x 5” 181.0 x 131.1 2138 x 1548 4276 x 3096 

(6x4) 
Portrait 6” x 4” 156.1 x 105.0 1844 x 1240 3688 x 2480 

Landscape 4” x 6” 105.0 x 156.1 1240 x 1844 2480 x 3688 

(6x4.5) 
Portrait 6”x 4.5” 156.1 x 117.3 1844 x 1386 3688 x 2772 

Landscape 4.5”x 6” 117.3 x 156.1 1386 x 1844 2772 x 3688 

(6x6) 
Portrait 6” x 6” 156.1 x 155.4 1844 x 1836 3688 x 3672 

Landscape 6” x 6” 155.4 x 156.1 1836 x 1844 3672 x 3688 

(6x8) 
Portrait 6” x 8” 156.1 x 206.2 1844 x 2436 3688 x 4872 

Landscape 8” x 6” 206.2 x 156.1 2436 x 1844 4872 x 3688 

(6x9) 
Portrait 6”x 9” 156.1 x 232.0 1844 x 2740 3688 x 5480 

Landscape 9”x 6” 232.0 x 156.1 2740 x 1844 5480 x 3688 

PR (3.5x5) 
Portrait 3.5” x 5” 92.1 x 131.1 1088 x 1548 2176 x 3096 

Landscape 5” x 3.5” 131.1 x  92.1 1548 x 1088 3096 x 2176 

PR (4x6) 
Portrait 4” x 6” 105.0 x 156.1 1240 x 1844 2480 x 3688 

Landscape 6” x 4” 156.1 x 105.0 1844 x 1240 3688 x 2480 

PR (4.5x6) 
Portrait 4.5”x 6” 117.3 x 156.1 1386 x 1844 2772 x 3688 

Landscape 6”x 4.5” 156.1 x 117.3 1844 x 1386 3688 x 2772 

 
*1: Convert to 300 x 600 dpi size within the driver, and then send to the printer. 
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2.6 Orientation  
 
The following chart shows the relationship of images generated by an application and printed items (output 
direction) according to the orientation setting.  
 

Hint: The PR print size (center column) is prepared for applications that are not able to change from 
landscape to portrait and back using the orientation setting on the layout tab.  Normally it is 
recommended to use the non-PR print sizes and use the orientation settings for landscape and 
portrait on the layout tab. 

 

 
  

Original 
image 

Driver setting 

Orientation 

Paper setting 

(5x3.5) 

(5x5) 
(6x4) 
(6x4.5) 
(6x6) 

PR (3.5x5) 

PR (4x6) 
PR (4.5x6) 

(5x7) 

(6x8) 
(6x9) 

Generated 

image 

Printed item 

(Output 

orientation ↓) 

Generated 

image 

Printed item 

(Output 

orientation ↓) 

Generated 

image 

Printed 

item 

(Output 

orientation 

↓) 

 

 
 
 
Portrait  
 
 
 

  

 
 

 
  

 
 
 
Landscape 
 
 
 

 
 

   
 

 

 
 
 
Portrait  
 
 
 

  

 
 

  

 
 
 
Landscape 
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Chapter 3 Update the driver 
 
As when performing the installation, log in as an administrator before carrying out this operation. 
 
1. Check the job 
 

1) Before deleting the printer driver, close all applications.  Furthermore, click on the icon of the printer to be 
deleted in the Devices and Printers screen.  At the bottom area of the screen, confirm that there are no 
documents in the queue, and then start deletion of the driver. 

 
Note: In Windows 8 and 10, when the printer is offline (the printer is not on and connected), the “CITIZEN 

CX-02” icon is not displayed.  
Always connect the printer with the power turned on and check that there are no documents in the 
queue. 

 
Figure 3.1 Clicking the “CITIZEN CX-02” icon at the Devices and Printers screen 
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2. Uninstall the driver package 

1) Click “Start”, and then click “Windows System” -> “Control Panel”.  In the Control Panel, click “Uninstall a 
program”. 
In Windows 7, click “Start”, and then click “Control Panel”.  In the Control Panel, click “Uninstall a 
program”. 
In Windows 8, right click the “Start” screen.  In the bottom right area, select “All Apps”, and then select 
“Control Panel”.  In the Control Panel, click “Uninstall a program”. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.2 Control Panel 
 
 

2) The Uninstall or change a program screen appears.  In the list, double click “CITIZEN CX-02”. 
 

 
Figure 3.3 Uninstall a program 
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3) Click “Yes” when the CITIZEN CX-02 uninstall confirmation windows appears. 

Uninstalling the driver is complete.  
After uninstalling the printer package, restart the computer. 

 

 
Figure 3.4 Uninstallation confirmation 

 
 

When a User Account Control dialog box appears, click “Yes”. 
 

 
Figure 3.5 User Account Control 

 
 
3. Install an upgrade for the printer driver 

After deleting the printer and the printer driver, install the new printer driver. 
For the installation procedure, see “Chapter 1 Installation”. 

 
 
4. Restart the computer 

After the installation of the printer driver is complete, always restart the computer. 
(Do not print just after installation. Always restart the computer once.) 
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Chapter 4 Delete the driver 

4.1 Automatic deletion of printer drivers 
 
The printer driver is automatically deleted when uninstalling the driver package. 
For the steps to uninstall the driver package, see “2. Uninstall the driver package” in Chapter 3. 
 
Note that uninstalling the driver package when the printer driver is in use will display the following message, 
and the printer driver will not be deleted. 
 

 
Figure 4.1 Message displayed when the driver is in use 

 
When the above message is displayed, restart the computer and then delete the printer driver using the 
procedure described in “ 
4.2 Manual deletion of printer drivers”. 
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4.2 Manual deletion of printer drivers 
 

1) Click “Start”, and then click “Windows System” -> “Control Panel”.  In the Control Panel, click “View 
devices and printers”. 
In Windows 7, Click “Start”, and then click “Control Panel”.  In the Control Panel, click “View devices 
and printers”. 
In Windows 8, right click the “Start” screen.  In the bottom right area, select “All Apps”, and then select 
“Control Panel”.  In the Control Panel, click “Devices and Printers”. 

 
From the Devices and Printers screen, right click “CITIZEN CX-02”.  From the menu, click “Remove 
device”. 

 

 
Figure 4.2.1 Right clicking “CITIZEN CX-02” in the Devices and Printers screen 
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In Windows 8 and 10, when the printer is offline (the printer is not on and connected), “CITIZEN CX-02” 
icon is not displayed.  In such cases, use the following procedure to delete the device. 

 
(i) On an empty area in the Devices and Printers screen, right click, and then select “Device Manager”. 

 

 
Figure 4.2.2.i Right clicking on an empty area in the Devices and Printers screen 

 
(ii) Click “View”, and then select “Show hidden devices”. 

 

 
Figure 4.2.2.ii Displaying the View menu for hidden devices 

 
(iii) Under “Printers”, right click “CITIZEN CX-02”, and then select “Uninstall device”. 

 

 
Figure 4.2.2.iii Displaying the menu to delete CITIZEN CX-02 

 
(iv) At the Uninstall Device screen, click “Uninstall”. 

 

 
Figure 4.2.2.iv Uninstall Device screen 
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2) The printer deletion confirmation dialog box appears.  Click “Yes”. 

 

 
Figure 4.2.3 Printer deletion confirmation dialog box 

 
3) After deleting “CITIZEN CX-02”, select another printer (for example, Fax), and then click “Print Server 

Properties” in the menu bar. 
 

 
Figure 4.2.4 Displaying the Print Server Properties menu in the Devices and Printers screen 
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4) The Print Server Properties dialog box appears.  Click the “Drivers” tab. 

From the installed printer driver list, select “CITIZEN CX-02”, and then click “Remove...”. 
 

 
Figure 4.2.5 Printer Server Properties dialog box 

 
 

5) The Remove Driver and Package dialog box appears.  Select “Remove driver only”, and then click “OK”. 
 

 
Figure 4.2.6 Remove Driver And Package dialog box 
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6) The Print Server Properties confirmation dialog box appears.  Click “Yes”. 

 

 
Figure 4.2.7 Driver deletion confirmation dialog box 

 
If the following message appears, the operating system may be using the driver (Print Spooler service) in 
the background.  Disconnect the USB cable and then restart your computer and try deleting the printer 
driver again. 

 

 
Figure 4.2.7.i Driver in use 

 

 
7) In the Print Server Properties dialog box, confirm that “CITIZEN CX-02” was deleted, and then click 

“Close”. 
 

 
Figure 4.2.8 Print Server Properties 

 
 


